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VIRTYUALAINSTITYUTE ~HIGHPRODUCTIVITY SUPERCOMPUTING

Extrae Features

Platforms
= Intel, Cray, BlueGene, Intel MIC, ARM, Android, Fujitsu Sparg, ...

Parallel programming model
= MPI, OpenMP, pthreads, OmpSs, CUDA, OpenCL, Java, Python, ...

Performance counters No need to

= Using PAPI interface I‘ecom_pile
or relink!

Link to source code
= Callstack at MPI routines
= OpenMP outlined routines

= Selected user functions

Periodic samples

= User events (Extrae API)
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VIRTYUALAINSTITYUTE ~HIGHPRODUCTIVITY SUPERCOMPUTING

Extrae Overheads

Event 150 - 200ns 238ns
Event + PAPI 750 - 1000ns

Event + callstack (1 level) 1us 1854ns
Event + callstack (6 levels) 2s 5700ns
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VIRTYUALAINSTITYUTE ~HIGHPRODUCTIVITY SUPERCOMPUTING

How does Extrae work?

= Symbol substitution through LD_PRELOAD

= Specific libraries for each combination of runtimes Recommended

= MPI, OpenMP, MPI+OpenMp, ...

» Dynamic instrumentation
» Based on DynlInst (developed by U.Wisconsin/U.Maryland)

= Instrumentation in memory

= Binary rewriting

= Static link (i.e., PMPI, Extrae API)
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Using Extrae in 3 steps

X X K XNARTYALANSTITYUTE - >HIGH-PRODUCTIVITY SUPERCOMPUTING

1. Adapt your job submission script

= Append Extrae loader script

2. Configure what to trace

» Modify extrae.xml

3. Run it!

» For further reference check the Extrae User Guide

= https://tools.bsc.es -> Documentation -> Tools manuals

= Also distributed with Extrae in SEXTRAE HOME/share/doc
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Using Extrae in Isambard-XCI

laptop> ssh isambard-xci
xcilee> cp -r /home/ri-emercada/tools-material $HOME
xcilee> 1ls $HOME/tools-material

apps/

clustering/

extrae/

slides/

traces/
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Step 1: Append loader script

xcilee> vi $HOME/tools-material/extrae/job.pbs

#!/usr/bin/env bash

#PBS -N "lulesh2.0_27p"
#PBS -1 select=1 Request
#PBS -1 walltime=00:10:00 resources
#PBS -q arm

cd $PBS_O_WORKDIR

export OMP_NUM THREADS=1 Run the program

aprun -n 27 ../apps/lulesh2.0 -1 10 -s 65 -p
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Step 1: Append loader script

xcilee> vi $HOME/tools-material/extrae/job.pbs

#!/usr/bin/env bash

#PBS -N "lulesh2.0 27p"
#PBS -1 select=1

#PBS -1 walltime=00:10:00
#PBS -q arm

cd $PBS_O_WORKDIR Name of the
resulting trace

export OMP_NUM_THREADS=1
export TRACE_NAME=lulesh2.0 27p.prv

aprun -n 27 ./trace.sh ../apps/lulesh2.0 -i 10 -s 65

Activate Extrae
during the run
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Step 1: Append loader script

VIRTYUALAINSTITYUTE ~HIGHPRODUCTIVITY SUPERCOMPUTING

xcileo> vi $HOME/tools-material/extrae/trace.sh

#!/usr/bin/env bash

#PBS -N "lulesh2.0 27p"
#PBS -1 select=1

#PBS -1 walltime=00:10:00
#PBS -q arm

cd $PBS_O_WORKDIR

export OMP_NUM_THREADS=1
export TRACE NAME=lulesh2e© 27p.prv

aprun -n 2 ./apps/luleshz.e -i 10 -s 65

32NP VI-HPS TUNING WORKSHOP (BRISTOL, UK, 24-26 APRIL 2019)

#!/usr/bin/env bash

# Configure Extrae
export EXTRAE_HOME=../extrae/3.6.1/cray-mpich_7.7.6

export EXTRAE_CONFIG_FILE=./extrae.xml
# Load the tracing library What to trace

export LD _PRELOAD=${EXTRAE_HOME}/lib/libmpitrace.so

# Run the program
$>I<

Type of
application
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Step 1: Append loader script

VIRTYUALAINSTITYUTE ~HIGHPRODUCTIVITY SUPERCOMPUTING

= Choose depending on application type

mm OpenMP | pthread | CUDA

libseqgtrace
libmpitrace[f]!
libomptrace
libpttrace
libcudatrace
libompitrace[f] !
libptmpitrace[f] 1
libcudampitrace[f] 1

32NP VI-HPS TUNING WORKSHOP (BRISTOL, UK, 24-26 APRIL 2019)
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v
v

1 Append “f” suffix for Fortran codes
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Step 3: Run it!

= Submit your job & check status

xcileo> cd $HOME/tools-material/extrae
xcilee> qsub job.pbs

xcileo> qstat -u $USER

= Once finished the trace will be in the same folder
" Julesh2.0 27p.{pcf,prv,row}

= Any issue?
» Traces already generated in SHOME/tools-material/traces
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Step 2: Configure what to trace

xcileo> vi $HOME/tools-material/extrae/extrae.xml

<mpi enabled="yes">
<counters enabled="yes"
</mpi> Trace MPI calls

<openmp enabled="no">
<locks enabled="no" />
<counters enabled="yes" />
</openmp>

Trace the call-stack

(Where in the code?)

<callers enabled="yes">
<mpi enabled="yes">1-3</mpi>
<sampling enabled="no">1-5</sampling>
</callers>

32NP VI-HPS TUNING WORKSHOP (BRISTOL, UK, 24-26 APRIL 2019)

(What is the program doing?)
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Step 2: Configure what to trace

xcileo> vi $HOME/tools-material/extrae/extrae.xml

<counters enabled="yes">
<cpu enabled="yes" starting-set-distribution="1">
<set enabled="yes" domain="all" changeat-time="500000us">
PAPI_TOT_INS,PAPI TOT_CYC,PAPI L1 DCM,PAPI_L2 DCM,PAPI_BR_INS,PAPI SR _INS,PAPI LD INS
</set>
<set enabled="yes" domain="all" changeat-time="500000us">
PAPI_TOT_INS,PAPI TOT_CYC, PAPI_FP_INS

</set>
</cpu>
<network enabled="no" />
<resource-usage enabled="no" /> Select which HW counters
<memory-usage enabled="no" /> are measured
</counters>

(How's the machine doing?)

32NP VI-HPS TUNING WORKSHOP (BRISTOL, UK, 24-26 APRIL 2019) 14
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Step 2: Configure what to trace

xcileo> vi $HOME/tools-material/extrae/

<buffer enabled="yes">
<size enabled="yes">5000000</size> €= Trace buffer size

<circular enabled="no" /> (Flush / memory trade-off)
</buffer>

<sampling enabled="no" type="default" period="50m" variability="1em" />

Enable periodic sampling

<merge enabled="no" (More details)
synchronization="defa

tree-fan-out="16"

max-memory="512" Automatic post-processing
joint-states="yes" to generate

keep-mpits="yes" the Paraver trace
sort-addresses="yes"

overwrite="yes">
$TRACE_NAME$
</merge>
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VIRTYUALAINSTITYUTE ~HIGHPRODUCTIVITY SUPERCOMPUTING

Install Paraver in your laptop

Extrae Research » Documentation » Downloads Publications.

= Download a binary for your OS

Home » Downloads

» https://tools.bsc.es/downloads Do

CORE TOOLS

CMTRAE PARAVER DIMEMAS

Expressive powerful and flexible trace visualizer for High-abstracted network simulator for message-

Instrumeniavian framework to generate execution
traces of the most used narallel runtimes. post-mortem trace analysis.

‘ Get PARAVER - Cet DIMEMAS -

Version 3.4.1+2.24 MB Moo e Version 5.2.12 « 1.00 MB

= O e R 8 A = & £ 6
+ + +

PERFORMANCE ANALYTICS

CLUSTERING TRACKING FOLDING

Analyze how the behavior of a parallel application Combined instrumentation and sampling for

passing programs.

; wxparaver-4.8.1-win.zip

E wxparaver-4.8.1-mac.zip

Automatically expose the main performance trends in
applications’ computation structure. evolves through different scenarios. instantaneous metric evolution with low overhead.

Get CLUSTERING - Get TRACKING h Get FOLDING -

Version 1.0.2 + 11.06 MB

wxparaver-4.8.1-Linux_i686.tar.gz (32bit)
=¥l wxparaver-4.8.1-Linux_x86_64.tar.gz (64bit)

Version 2.6.6+«2 MB Version 2.6.5+ 1.9 MB

+ + +

SPECTRAL BASIC ANALYSIS

Signal processing techniques to select representative Framework for automatic extraction of fundamental

= Also available in Isambard-XCI
* /home/ri-emercada/tools-packages 1 SPECTRAL ~

Version 3.4.0+ 0.31 MB Version 0.2 « 10.89 MB

+ +
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Install Paraver tutorials

@ Home  Paraver»  Dimemas»  Extrae  Research»  Documentation » ~ Downloads  Publications

= Download tutorials archive e —————T
u https . //tOOIS [ bSC- eS/Da rave r_tUtO rla | S Home » Documentation » Paraver tutorials

These seven tutorials can be opened with wxParaver versions newer than 4.3.0, and you'll be able to follow the steps within the tool. To install them. download
and untar the package and follow the instructions of the Help/Tutorial option on the Paraver main window. Following there is a list of available tutorials:

B9 paraver introduction (ME Start here € with Paraver basic commands and the first steps of a

N how to configure and run the Dimemas simulator and to start

pplication through well-known

3.introduction to paraver and dimemas methodology.tar.gz

nclu

done using the provided

s of the MPI application Hydro and further

o o oo

a representative region for a large trace that cannot be

O

Trace preparatior

wards communications, use this

a

ace alignment tutorial

Wy nrefer you can download all of them togheter in a single package:

paraver-tutorials-20150526.tar.gz tar gz format (127 M) 2o format (127 b)

= Also available in Isambard-XCI
»= /home/ri-emercada/tools-packages

32NP VI-HPS TUNING WORKSHOP (BRISTOL, UK, 24-26 APRIL 2019) 18


https://tools.bsc.es/paraver-tutorials
https://tools.bsc.es/paraver-tutorials
https://tools.bsc.es/paraver-tutorials
https://tools.bsc.es/paraver-tutorials

VIRTYUALAINSTITYUTE ~HIGHPRODUCTIVITY SUPERCOMPUTING

Uncompress, rename & move

= Paraver

laptop> tar xf wxparaver-4.8.1-Linux_x86_64.tar.bz2

laptop> mv wxparaver-4.8.1-Linux_x86_64 paraver

= Tutorials

laptop> tar xf paraver-tutorials-20150526.tar.bz2

laptop> mv paraver-tutorials-20150526 paraver/tutorials
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Check that everything works

= Start Paraver

laptop> $HOME/paraver/bin/wxparaver &

Tutorials

» Check the tutorials are available

Barcelona

Supercomputing

Center

Cantra Nacional de Supercomputacicn

File Hints | Help IndE){
B . . Help Contents...

Workspaces Tutaorials...

About. ..
INonE —

Window browser
IAIITraces

1. Introduction to Analysis with Paraver - MPI

2. Introduction to the Use of Dimemas

3. Introduction to Paraver and Dimemas methodology

4. Analysis with Paraver & Dimemas - Methodology

Click on Help > Tutorials

5. HydroC Tutorial

B. Paraver trace preparation
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First steps of the analysis

= Copy the trace to your laptop

laptop> scp isambard-xci:$HOME/tools-material/extrae/lulesh2.0 27p.{prv,pcf,row} ./

» Load the trace File Hint= Help
= File -> Load trace -> Browse to .prv file Load Trace..

Previous Traces 3

Tutorials

= Follow tutorial #3 (( garcelona
u H e | p - > TU tO rl a | S gee.r'ﬁg:ea\f';zca‘onal de Supercomputacion

Index

1. Introduction to Analysis with Paraver - MPT

2. Introduction to the Use of Dimemas

3. Introduction to Paraver and Dimemas methodology

&. Analysis WIth Fdrdver i« UIMemads - Methodology

5. HydroC Tutorial

6. Paraver trace preparation
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Measure the parallel efficiency

= Click on mpi stats.cfg

e B | O %I|I|H|H||||w L %

—
The first question to answer when analyzing a parallel code is "how efficient does it g _—
run?". The efficiency of a parallel program can be defined based on two aspects: the THREAD 1.18.1
parallelization efficiency and the efficiency obtained in the execution of the serial THREAD 1.19.1 _—_
regions. These two metrics would be the first checks on the proposed methodology. . .
» To measure the parallel efficighcy load the configuration file
cfgs upi- mnpi_stats.cfg Thif configuration pops up a table with %time that THREAD 1.21.1 _—_
every thread spends in every MPRcall. Look at the glebal statistics at the bottom of
rage represents the application parallel THREAD 1.22.1 _—_
efficiency, entry Avg/Max represents the global load balance and entry Maximum
represents the communication efficiency. If any of those values are lower than THREAD 1.23.1 _—_
85% is recommended to look at the corresponding metric in detail. Open the _—_
control window to identify the phases and iterations of the code THREAD 1.24.1
» To measure the computation time distribution load the configuration file [ElEal s ___
cfgssgeneral ~2dh_usefulduration. cfg This configuration pops up a THREAD 1.26.1 _—_
histogram of the duration for the computation regions. The computation regions
are delimited by the exit from an MPI call and the entry to the next call. If the THREAD 1.27.1 _—_
histogram does not show vertical lines, itindicates the computation time may be
not balanced. Open the control window to lock at the time distribution and visually
correlate both views.
Total 2,452.96 % 1.21% 1.25 % 6.95 % 30.3B% 0.11% 373%
s To measure the compu A
configuration file c£g —ﬁ 90.85 % 0.04 % 0.05% 0.26 % 113 % 0.00% 0.14 %

;‘;gﬂgg:su";h?:npj;;o: Pa a"el eff|C|ency Maximurng 97.22 % 0.08 % 0.08 % 0.79 % 258 % 0.01% 1.06 %
to the next call. If the hiswyriies S imum 83.22 % 0.03 % 0.03 % 0.02 % 0.37 % 0.00 % 0.00 %
distribution of the instrud

look at the time distribut StDev 3.80 % 0.01% 0.01% 0.16 % 0.67 % 0.00 % 0,32 %

« Tomezsure the cariz! Comm effiCiency Avg/M 0.93 0.56 0.56 0.32 0.44 0.73 0.13
sl =] -

[

=

Load balance
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Computation time and work distribution

» Click on 2dh usefulduration.cfg (2nd link) = Shows time computing

€ B [ @

The first question to answer when analyzing a parallel code is "how efficient does it
run?”. The efficiency of a parallel program can be defined based on two aspects: the
parallelization efficiency and the efficiency obtained in the execution of the serial I
regions. These two metrics would be the first checks on the proposed methodology. II

s To measure the parallel efficiency load the configuration file
cfgesnpisnpl stats cfgThis configuration pops up a table with %time that
every thread spends in every MPI call. Look at the global statistics at the bottom of
the outside mpi column. Entry Average represents the application parallel
efficiency. entry Avg/Max represents the global load balance and entry Maximum
represents the communication efficiency. If any of those values are lower than
85% is recommended to look at the corresponding metric in detail. Open the
control window to identify the phases and iterations of the code

e To measure the computation time distribution I@ad the configuration file
cfgsrgeneral ~2dh_ussfulduration ofg This Bonfiguration pops up a
histogram of the duration for the computation regiofls. The computation regions

sholimioasisbils ———— to the next call. If the
histogram does not show vertical lines, it indicates the computation time may be
not balanced. Open the control window to look at the time distribution and visually
correlate both views

e To measure the computational load (instructions) distribution load the
configuration file cf g=rpapi 2dh_ussful instructions ofg This
configuration pops up a histogram of the instructions for the computation regions.
The computation regions are delimited by the exit from an MPI call and the entry
to the next call. If the histogram doesn't show vertical lines, itindicates the
distribution of the instructions may be not balanced. Open the control window to
look at the time distribution and correlate both views

Performance

imbalance
=] = - i I (zig-zag)

a Tn measure the serial reninns narfarmance Innk at the TPC timeline Inaded LI

[26,053.95.,.28,057.90)
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Computation time and work distribution

= ...and 2dh useful instructions.cfg (3rd link) & Shows amount of work

The first question to answer when analyzing a parallel code is "how efficient does it
run?”. The efficiency of a parallel program can be defined based on two aspects: the
parallelization efficiency and the efficiency obtained in the execution of the serial
regions. These two metrics would be the first checks on the proposed methodology.

s To measure the parallel efficiency load the configuration file
cfgesnpisnpl stats cfgThis configuration pops up a table with %time that
every thread spends in every MPI call. Look at the global statistics at the bottom of
the outside mpi column. Entry Average represents the application parallel
efficiency. entry Avg/Max represents the global load balance and entry Maximum
represents the communication efficiency. If any of those values are lower than
85% is recommended to look at the corresponding metric in detail. Open the
control window to identify the phases and iterations of the code

e To measure the computation time distribution load the configuration file
cfgsrgeneral ~2dh_ussfulduration ofg This configuration pops up a
histogram of the duration for the computation regions. The computation regions
are delimited by the exit from an MPI call and the entry to the next call. If the
histogram does not show vertical lines, it indicates the computation time may be
not balanced. Open the control window to look at the time distribution and visually
correlate both views

e To measfre the computational load (instructions) distribution logd the
configuraion file cf gsrpapi 2dh ussful instructions ofg Thi
configuralion pops up a histogram of the instructions for the computatfpn regions.

to the next call. If the histogram doesn't show vertical lines, itindicates the Wo rk
distribution of the instructions may be not balanced. Open the control window to
look at the time distribution and correlate both views

imbalance
a Tn measure the serial reninns narfarmance Innk at the TPC timeline Inaded LI

=l = o |
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Where does this happen?

= Go from tables to timelines

useful instructions 20Zcom range [1,80809e+08,4,27962e+08) @ lulesh2.0 27p.prv
THREAD 1.1.1

2dh useful instructions @ lulesh2.@ 27p.prv

|| IH | =
L — THREAD 1.13.1

Click on : THREAD 1.19.1
“Open Filtered . j THREZD 1.27.1
Control Window”

0 us 294, 274, 992,296, 002, 586 7,639,470 us

Right click >
Fit Semantic Scale >
Fit both

Select imbalanced 5,486,748.27)

area
(by drag-and-

dropping)
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VIRTYUALAINSTITYUTE ~HIGHPRODUCTIVITY SUPERCOMPUTING

Where does this happen

" m & at the same time = Imbalance

2dh useful instructions @ lulesh2.0 27p.prv

€ B [ &

THREAD 1.1.1

THREAD 1.18.1

THRE&AD 1.19.1

THREAD 1.27.1

Zoom into

1 of the iterations
(by drag-and-dropping)

THREAD 1.1.1

THREAD 1.1A8.1

[502,560,504.63..506,486,748.27) THREAD 1.19.1

THREAD 1.27.1

242,377,332

32NP VI-HPS TUNING WORKSHOP (BRISTOL, UK, 24-26 APRIL 2019)

useful instructions 20Zcom range [1,80809e+08,4,27962e+08) @ lulesh2.0 27p.prv

useful instructions 20Zoom range [1.84535e+08,4,24036e+08) @ lulesh2.0 27p.prv

7,629,478 us

2,600,358 us
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Where does this happen

= Hints &> Callers - Caller function

2dh useful instructions @ lulesh2.0 27p.prv useful instructions 20Zcom range [1,84535e+08,4,24036e+08) @ lulesh2.0 27p.prv

e B i hg ITIT s omla ¢ ow THREAD 1.1.1

THREAD 1.18.1

- THRERD 1.19.1 - =
|

THREAD 1.27.1

Right click > Copy ;

,,,,, 242’ 33'1_ 332 2,600,358 us

Right click I caller @ lulesh2.0 27p.prv
- Paste 2 Time w11
READ 1.5.1
THREAD
THREAD 1.13.
THREAD 1.17.
[502,560,504.63..506,486,748.27) THREAD 1.2

THREAD
THREAD

2,247,767 us 2,600,358 us

CommMonoQ Timelncrement

32NP VI-HPS TUNING WORKSHOP (BRISTOL, UK, 24-26 APRIL 2019) 27
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Save CFG’s (2 methods)

Right click Copy CTRL+C
on Paste 2

useful instructions 2DZoom range [1.84535Se+08,4.24036e+08) @ luleshz.0_27p.prv tlmellne Clone

THREAD 1.1.1

THREAD 1.14@.1

Undo Zoom CTRL+L
THREAD 1.19.1 I T e - L -

THREAD 1.27.1 . p— Fit Time Scale

2,247,767 us

Fit Semantic Scale 2
Fit Objects
Select Objects...

View

Paint As
Drawmode
Pixel Size
Object Labels
Object Axis

b . . . .

w

Run

Synchronize +

Configuration...
Image...

Image Legend...
Text...

Timing CTRL+T
Info Panel

T
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Save CFG’s (2 methods)

VIRTYUALAINSTITYUTE ~HIGHPRODUCTIVITY SUPERCOMPUTING

useful instructions
THREAD 1.1.1

THREAD 1.14@.1
THREAD 1.19.1

THREAD 1.

DZoom range [1.8453Se+08,4.24036e+08) @ luleshz.0_27p.prv

242,377,332

1. Main

Paraver
window

File Hints Help

Load Trace
Previous Traces »
Unload Traces..

Load Configuration
Previous Configurs

Load Session CTRL+!

Save Session CTRL+S

Preferences,

Quit

[ -] 2dh userul instructions
b useful instruction oM ran
&1 83 MPI caller

< | |

flulesh2.0_27p.prv

Timelines

=

Histograms

useful instructions @ Iuleshz.ﬂ_d
Instructions.cl @ lulesh2.0_27¢
 Useful.cl @ lulesh2.0_27p.prv

v useful instructions 00m rarg
ructions.clcl @ lulesh2.0_
Lelel @ lulesh2.0 _27p.pr
Nler @ lulesh2 0 _27p.prv
aller @ lulesh2.0_27¢

Description

R ulesh2.0_27p.prv 2

Set all

MPI call profile @ lulesh2.0_27p.prv
2DH useful duration correlated witl
2dh useful instructions @ lulesh2.0

Set all Unset all I

ave configuration

~ Timeline options

¥ Relative begin time
¥ Relative end time

l Compute semantic scale

— Histogram options
@ All trace
© All window

v Compute gradient limits

-

[~ Save whole CFGin basic mode

Save |

Cancel |

I ——————"""
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CFG’s distribution

= Paraver comes with many more included CFG's

File Hints Help

Load Trace...
Previous Traces »

Unload Traces...

Load Configuration...

Previous Configurations O Look jn: IE' cfgs j ﬁl ﬂl E,Il El?

Save Configuration...

Load Session... CTRL+I - —= ' . .
Save Session . CTRL+S burst_mode B_I ava B sampling+folding
Preferences... _ cluste Fil'lg B I'I'IFII B S5C riptE
ith N N N
Quit counters_PAPI IS ompss [ software_counters

| 2dh useful instructions
-- €3 useful instructions 2DZoom range [1.601542+0(
(- €3 MPI caller

] CUDA IS opencL IS spectral
I folding [ openMp
( | &l | General IS pthread

Files & Window Properties

-] lib -]
D libbsctools )

- share File name: j DOpen
- sre ot

D Telegram J

:gu_ncrusm Files of type: Paraver configuration file (*.cfg) j Cancel
ElE' paraver

i @B hurct moada

Paraver files

el
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Hints: a good place to start!

= Paraver suggests CFG’s based on the information present in the trace

File | Hints Help

HE MPI profile

Work: callers p Point 2 point connectivity pattern

IF HWC » Histogram of durations per MPI call
flush W Histogram of message sizes per call

Windoworowser

| lulesh2.0_27p.prv |

-~ MPI call
- MPI call prafile
../ =8 Useful Duration
- % Instructions per cycle
-] 2DH useful duration correlated with
[#- &3 useful instructions
-] 2dh useful instructions
- &8 useful instructions 2DZoom range [1.60154e+0(
- &8 MPI caller

1| |

Files & Window Properties

= lib B
&[] libbsctools

&[] share

&[] sre

&[] Telegram J
&£ uncrustify

i m, B huret_mada

Ledle

Paraver files
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Cluster-based analysis
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Install Clustering in your laptop

= Download a binary for your OS
» https://tools.bsc.es/downloads

laptop> tar xf clusteringsuite-2.6.8-Linux_x86_64.tar.bz2

laptop> mv clusteringsuite-2.6.8-Linux_x86_64 clustering

= Also available in Isambard-XCI
*= /home/ri-emercada/tools-packages
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Use clustering analysis

= Run clustering

laptop> cd $HOME/tools-material/clustering
laptop> $HOME/clustering/bin/BurstClustering \
-d cluster.xml \
-i ../extrae/lulesh2.0 27p.prv \
-0 lulesh2.0 27p clustered.prv

= If you didn’t get your own trace, use a prepared one from:

xcilee> 1ls $HOME/tools-material/traces/lulesh2.0 27p.prv
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Cluster-based analysis

= Check the resulting scatter plot

laptop> gnuplot lulesh2.0 27p clustered.IPC.PAPI_TOT_INS.gnuplot

Gnuplot window O

H 0 6 0O N
ve im L R !

= Identify main computing trends Cusor At Resls o race ulesh2.0.70

8
810 Noise  +

Cluster 1
o Cluster 2
7x108 - B Cluster3 ¢

Cluster4 m
= Work (Y) vs. Speed (X)
g | 4 Clusters @
Ex10 Cluster 7
Cluster 8
Cluster 9
Cluster 10
Cluster 11 «
Cluster 12

= Look at the clusters shape
= Variability in both axes indicate
potential imbalances

Instructions Compy

Variable work

1.3

0.372643, 5.6352
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Correlating scatter plot and time distribution

= Open the clustered trace with Paraver and look at it

laptop> $HOME/paraver/bin/wxparaver /lulesh_27p clustered.prv

= Display the distribution of clusters over time
= File > Load configuration - $HOME/paraver/cfgs/clustering/clusterID window.cfg

Cluster ID @ lulesh2.0 27p clustered.prv

Gnuplot window
HH- 6 6 @ &
HE "\ ™\ N\ 4
- ' | Cluster Analysis Results of trace 'lulesh2.0,7p.prv'
Variable work /
8x10° T T T T T T T Nolse  +
Cluster
speed °
= 7x10° [ q Cluster
L + Cluster ]
Cluster
6x10° i Cluster ®
— - Cluster
t
8L B t

g Cluster 2 Simultaneously
Cluster ID @ lulesh2.0 27p_clustered orv @ dlfferent

processes e _
i \ - L e

0.372643, 5.63862e+08

003U W N

Instructions Cofpleted
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